Trademarks
MiroCam®, MiroView™, IntroMedic, and the associated logos are the registered trademarks © or trademarks ™ of IntroMedic Co., Ltd. © IntroMedic Co., Ltd. July 2007.

Except as required by applicable copyright laws; any use of the IntroMedic trademarks, or any reprinting, reproduction, modification, referencing and translations of the User Manual, without the prior written approval of IntroMedic Co., Ltd. is strictly prohibited.

Warranty
Every effort has been made to ensure the information contained in this User Manual is accurate, and is believed to be correct at time of printing. IntroMedic reserves the right to change any content contained with this User Manual without prior notice.

IntroMedic Co., Ltd. warrants the product against defects in material and workmanship for a period of twelve (12) months from the date of sale, unless different local regulations apply. IntroMedic Co., Ltd. will repair or replace products that are ascertained by IntroMedic to have defects during the warranty period. IntroMedic Co., Ltd. is not liable for the defects occurred by misuse, careless handling, unauthorized modifications or erroneous use, or any use that is non-compliant with instructions detailed within this User Manual. This includes use of the product in non-appropriate locations or conditions. Any other warranties are neither represented here nor recognized by implication.

To validate the warranty, please complete product registration with the local authorized IntroMedic distributor.
**Warranty**

**Exclusive warranty service**
The warranty service provided hereby is applicable exclusively to the purchaser of the product. IntroMedic will only warranty the product for purposes and usage as defined in this User Manual. Any usage not heeding the warnings, cautions and recommended usages as defined in this manual will nullify the warranty.

**Support**
For warranty or repair service please contact the local authorized IntroMedic distributor.

For customer service or support please contact your point of purchase or IntroMedic Co., Ltd. Service agreements are only applicable to products of IntroMedic Co., Ltd.

**IntroMedic Customer Service**
TEL: 82-2-801-9300  
FAX: 82-2-801-9330  
http://www.intromedic.com  
E-mail: helpdesk@intromedic.com

**Safety**
Non-compliance with the user’s manual, unauthorized modifications of the product or replacement of parts, and/or opening of the product casing is prohibited and may be hazardous.

**Declaration on translation of labeling**
Based on buyer's request, IntroMedic will provide the labeling, such as ID label, Instruction for use and other promotional materials, which is translated into the national language(s) of European countries. And it will be evaluated by the local language expert, and will be confirmed by the native speaker of the local language.
## CONTENTS

1. SAFETY INFORMATION 3
   1.1 Warnings 3
   1.2 Symbols for Safety 4
   1.3 Function Symbols 5
   1.4 Notes for Safe Use 9

2. SYSTEM OVERVIEW 3
   2.1 Intended Purpose 3
   2.2 Observable Diseases 4
   2.3 Product Lifetime 6
   2.4 Product Specification 7

3. PERFORMING CAPSULE ENDOSCOPY 3
   3.1 General Comments 3
   3.2 Safety Warnings 3
   3.3 Examination Preparation 4
   3.4 Patient Preparation 6
   3.5 Sensor Placement & Capsule Ingestion 7
   3.6 Uploading Images 16
   3.7 Receiver Management – Post Procedure 17
4. USING MIROVIEW™
   4.1 MiroView™ H/W Specifications
   4.2 Overview – MiroView™ Server
   4.3 Overview – MiroView™ Operator
   4.4 Overview – MiroView™ Client
   4.5 Overview – MiroView™ Viewer
   4.6 Performing Capsule Endoscopy
   4.7 How to import MiroView™ 1.0 files

5. USING MIROVIEW™ RTV
   5.1 Overview
   5.2 Using MiroView™ RTV

6. USING WIRELESS MIROVIEW™ RTV
   6.1 Overview
   6.2 Using Wireless MiroView™ RTV
Safety Information
1. SAFETY INFORMATION

1.1 Warnings

MiroCam® has been manufactured to conform with the International Standard for Medical Electrical Equipment: General Requirements for Safety IEC 60601-1, together with the Collateral Standard for Electromagnetic Compatibility Requirement and Tests IEC 60601-1-2.

MiroCam® has been manufactured to conform to the electric shock, fire and mechanical hazard standards as defined in CAN/CSA C22.2 NO.601.1.

Based on request of the buyer, IntroMedic will provide the labeling, such as ID labels, and the User Manual in the national language(s) of European countries. Translated documents will be evaluated by a local language expert, and will be confirmed by a native speaker of the respective national language.

Safety Symbols: The User Manual incorporates various safety symbols to ensure safe and correct use of the product and to prevent any personal injury or property damage. These symbols are defined in the following table:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>WARNING indicates a potential hazard that, if not avoided, could result in serious personal injury or damage to the product.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>CAUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>CAUTION indicates a potential hazard that, if not avoided, could result in minor personal injury or damage to the product.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Symbol</th>
<th>NOTE</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Symbol]</td>
<td>NOTE does not indicate potential hazards as in Caution or Warning, but contains important information regarding the installation, operation or maintenance of the product.</td>
</tr>
</tbody>
</table>
1.2 Symbols for Safety

This section describes a set of symbols that the IEC (International Electrotechnical Commission) has established for medical electronic equipment to classify connections and warnings of any potential hazards.

IEC 348: Notice for the user to pay special attention to the following details

IEC 878-02-03: Indicates that this is classified into Type BF equipment

EN 980: Denotes Date of Manufacture

EN 980: Denotes Address of Manufacture

IEC60601, ANNEX D: Denotes “ON” status of main power switch

IEC60601, ANNEX D: Denotes “OFF” status of main power switch

EN 980: Denotes serial number

IEC 417-5031: Denotes DC (Direct Current)

IEC 417-5032: Denotes AC (Alternating Current)

Denotes Ampere, the unit of current

Denotes Volt, the unit of Voltage

Denote Hertz, the unit of Frequency

IEC 417-5021: Denotes potential equalization terminal

Single Use Only

Use by date
### 1.3 Function Symbols

#### 1.3.1 MiroView™ Function Symbols

The following table describes symbols or icons used in the MiroView™ software.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Connect to the receiver and open receiver control screen.</td>
<td><img src="image" alt="Symbol" /></td>
<td>Open the report screen to create a patient capsule endoscopy report.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Open the patient data screen.</td>
<td><img src="image" alt="Symbol" /></td>
<td>Open screen to export (save externally) selected image data for a specific patient.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Open screen to review for a specific patient</td>
<td><img src="image" alt="Symbol" /></td>
<td>Select and save an image being reviewed.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Place a landmark in an image being reviewed.</td>
<td><img src="image" alt="Symbol" /></td>
<td>Open the Color Enhancement Window</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Show images in full screen</td>
<td><img src="image" alt="Symbol" /></td>
<td>Time Display</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Show images in the Single Screen</td>
<td><img src="image" alt="Symbol" /></td>
<td>Show images in the Dual Screen.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Show images in the Quad Screen.</td>
<td><img src="image" alt="Symbol" /></td>
<td>Show images in the Range Mode.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Show images in the Map View</td>
<td><img src="image" alt="Symbol" /></td>
<td>Play all images.</td>
</tr>
<tr>
<td><img src="image" alt="Symbol" /></td>
<td>Play the selected images only. View images via Express Mode function.</td>
<td><img src="image" alt="Symbol" /></td>
<td>SGIB - Play the images captured via Suspected GI Bleeding function.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>----------------------------------------------------</td>
<td>--------</td>
<td>-------------------------------------------</td>
</tr>
<tr>
<td>Move to the previous image.</td>
<td>Move to the previous captured image.</td>
<td>Play images in reverse order.</td>
<td>Stop playback of images.</td>
</tr>
<tr>
<td>Play</td>
<td>Play images in sequential order.</td>
<td>Move to the next captured image.</td>
<td>Move to the next image.</td>
</tr>
<tr>
<td>Open the Positioning Window</td>
<td>Open the Comparison Window</td>
<td>Expand/Shrink Capture Box</td>
<td>Statistic Box</td>
</tr>
<tr>
<td>Show Circumference Markers</td>
<td>Add a Circle on the image</td>
<td>Add a Line on the image</td>
<td>Delete selected Circle / Line</td>
</tr>
<tr>
<td>Color Palette</td>
<td>Undo the action</td>
<td>Redo the action</td>
<td>Check selected captured images</td>
</tr>
<tr>
<td>Symbol</td>
<td>Description</td>
<td>Symbol</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>--------------------------------------</td>
<td>--------</td>
<td>---------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Uncheck selected captured images" /></td>
<td>Uncheck selected captured images</td>
<td><img src="image" alt="Print" /></td>
<td>Print</td>
</tr>
<tr>
<td><img src="image" alt="Review" /></td>
<td>Review</td>
<td><img src="image" alt="Save as PDF" /></td>
<td>Save as PDF</td>
</tr>
<tr>
<td><img src="image" alt="Export Review" /></td>
<td>Export Review</td>
<td><img src="image" alt="Open PACS function (Registered User Only)" /></td>
<td>Open PACS function (Registered User Only)</td>
</tr>
<tr>
<td><img src="image" alt="Export Captured Images with EXMIF" /></td>
<td>Export Captured Images with EXMIF</td>
<td><img src="image" alt="Export Captured Images as Image / Video / MiroVideo" /></td>
<td>Export Captured Images as Image / Video / MiroVideo</td>
</tr>
<tr>
<td><img src="image" alt="Export Segments as Image / Video / MiroVideo" /></td>
<td>Export Segments as Image / Video / MiroVideo</td>
<td><img src="image" alt="Export Case as Video / MiroVideo" /></td>
<td>Export Case as Video / MiroVideo</td>
</tr>
<tr>
<td><img src="image" alt="Select the area as a Segment" /></td>
<td>Select the area as a Segment</td>
<td><img src="image" alt="Deselect the area from Segment" /></td>
<td>Deselect the area from Segment</td>
</tr>
</tbody>
</table>
1.3.2 MiroCam® Receiver Function Symbols

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIG</td>
<td>Indicates status of signal from capsule</td>
</tr>
<tr>
<td></td>
<td>Green: Signal is being received from capsule</td>
</tr>
<tr>
<td></td>
<td>Yellow: Signal is not being received from capsule</td>
</tr>
<tr>
<td>INI</td>
<td>Initialization status of Receiver Unit</td>
</tr>
<tr>
<td></td>
<td>Green: Receiver is initialized</td>
</tr>
<tr>
<td></td>
<td>Yellow: Receiver is not initialized</td>
</tr>
<tr>
<td>BAT</td>
<td>Battery Status</td>
</tr>
<tr>
<td></td>
<td>Green: Fully charged</td>
</tr>
<tr>
<td></td>
<td>Yellow: Not charged</td>
</tr>
</tbody>
</table>
1.4 Notes for Safe Use

- Follow the safety instructions included in this User Manual and clinical precautions advised by the medical professional.
- The manufacturer is not liable for harm or damage caused by improper, unauthorized, unprofessional or inexpert use of the device and/or product.
- IntroMedic Co., Ltd. is NOT responsible for physical harm or equipment problems caused by the user’s careless operation or mismanagement of the device and/or product.
- Users MUST have read and understood the User Manual. ONLY trained and qualified medical professionals or authorized representatives of IntroMedic Co., Ltd. may operate the system.
- User Manual must ALWAYS be with the equipment. This is the USER’S RESPONSIBILITY.
- CAUTION: foreign substances including water, cleaning fluids, disinfecting cleanser and such substances may harm the equipment, and should not enter the equipment.
- ONLY authorized personnel may perform repairs. Never attempt to open covers, panels or casings.
- DO NOT crease, bend, fold or twist the data cables. Take care to guard them against mechanical stress (e.g. wheels or heels)!
- The sensor pads, receiver, data cables, and capsules must not be exposed to mechanical shock (e.g. by dropping). Any damage caused that way will void the product warranty.
- CAUTION: Damage/injuries to the sensor pad or data cable may cause a safety hazard. Damaged items MUST be repaired IMMEDIATELY.
- DO NOT handle fluids in the vicinity of the system.
- When using a cart purchased elsewhere, ensure the brake or latch guard is in use to prevent the wheels from rolling.
DO NOT USE in moist or damp places.

DO NOT operate the equipment with wet hands.

Avoid using the equipment in extreme temperatures or humid environments.

DO NOT keep the equipment or carry out the procedure in places such as areas exposed to direct sunlight, vicinity of heaters, vicinity of chemical materials or gases, areas moist/damp or dusty, or poorly ventilated areas.

DO NOT disassemble or open the equipment without permission. This will invalidate the warranty.

DO NOT carry out the procedure in areas with high vibrations or in environments where high electro-magnetic waves are generated.

DO NOT pull out the power cord by grabbing the cable. When disconnecting the power cord, grasp the plug, and pull out. This prevents short-circuits, disconnection, or cord damage.

CAUTION: Verify that the power voltage supplied from the power receptacle matches with the voltage the system requires. Check Voltage and Frequency on the AC/DC adaptor.

CAUTION: Turn off the power switch before connecting the sensor pad.

DO NOT discard sensor pads, cables and connectors with general waste. Discard separately as industrial or medical waste.

CAUTION: Discard the battery according to the regulations of industrial waste. DO NOT discard with general waste.

DO NOT carry out the procedure simultaneously with other procedures using medical products or equipment.

DO NOT use for purposes other than medical treatment.

DO NOT connect the USB cable to the receiver while the receiver’s data cable and sensor pads are still connected.

DO NOT charge the receiver while the receiver’s data cable and sensor pads are still connected.
Connect USB cable to receiver only after mounting it on charger.

DO NOT install any other programs onto the workstation utilized for review and diagnosis of patient image data (i.e., computers with the MiroView™ software).

The capsule is disposable and should not be reused.

The capsule and sensor pads are medical waste, and should be disposed of according to local regulations or WEEE directive on waste disposal.

Only use the capsule, receiver, data cables and sensor pads in the medical environment condition.

All products connected with the MiroCam® Endoscope system must be compliant with requirements of IEC60950-1 or UL certifications.

Check the outer surface of the endoscope for rough surfaces, sharp edges, or protrusions which may cause a safety hazard.

Please don’t try to cut the label.
1.4.1 Environmental Conditions for Operation

- **Temperature**: +0 °C - +40 °C
- **Relative humidity**: 45% - 75%
- **Atmospheric pressure**: 700hPa to 1060hPa

**WARNING** DO NOT operate the equipment in the vicinity of generators, power stations, X-ray devices, and broadcasting stations where high levels of electro-magnetic waves are generated. The electro-magnetic waves can cause equipment malfunctions.

**CAUTION** If the equipment has been brought in from a cold environment (stock room, airfreight) into a warm room, initial activation should take place after a few hours, to allow for temperature adjustment and balance and evaporation of condensed humidity.

**WARNING** DO NOT operate the equipment in the vicinity of heat sources, strong electric or magnetic fields (close to a transformer), or near instruments generating high-frequency signals.

**WARNING** Do not use MiroCam® alongside or together with medical devices or procedures involving electrical currents.

Do not use MiroCam® with h.f. surgical equipment. It may result in burns at the site of the electrodes and possible damage to the capsule and receiver.

Do not use the unit in close radius (within 1 m) of short wave or microwave therapy equipment. It may produce instability in the captured image.

**WARNING** This device is a Class B device according to EN60601-1-2 standards. This equipment can cause radio interference in residential areas. In this case, the owner (or operator) can be held responsible to take appropriate measures or take proper measures for compensation.
1.4.2 Safety Precaution

![CAUTION]

- Make sure the environment is without interference from electromagnetic fields.
- Make sure the environment is without noise and vibration.
- DO NOT carry out the procedure while using other equipments, devices or products.
- The instruction for use of the sensor pads MUST be observed.
- DO NOT use on patients with pacemakers or defibrillators.

![CAUTION]

DO NOT use the capsule if the package is unsealed.

- DO NOT reuse a used capsule.
- To prevent unexpected accidents like fire or explosion, do not use any product near or in the presence of inflammable or ignitable substances.
- DO NOT disassemble the equipment case nor open the cover. In case service is required, please contact IntroMedic customer support or local point of sale immediately.
- Only the accessories authorized and designed by IntroMedic Co., Ltd. should be used with this equipment. Faults resulting from the usage of unapproved or inappropriate accessories are not guaranteed against.
- This equipment may have an effect on other products or be effected by other products.
- Follow your doctor’s instructions and abide by the guidelines in the User Manual.
- DO NOT try to upload the data while the data cables are still connected to the receiver.
- DO NOT charge the rechargeable battery in the receiver while the data cable and sensor pads are still connected to the receiver.
Stay away from high frequency radiation sites (such as high voltage, radar, installation power plants, MRI, CT or electric blankets etc.) during your capsule endoscope procedure. (It may result in serious side effects requiring an emergency operation.)

In case of any symptoms of abdominal pain, vomiting, fever, heart trouble, dizziness or seizure during or after the capsule endoscope procedure, please notify your doctor.

Always check the connection between the receiver and the data cable.

Always check that the battery in the receiver is fully charged before use.

DO NOT use the capsule if the package is unsealed.

After ingesting the capsule, always check whether the capsule has been excreted.

Prior to undergoing the capsule endoscopy procedure, patients with diabetes must be informed via a medical professional regarding appropriate medication & dosage.

For more accurate data and better analysis, patients can have solid food for lunch, but must have liquid food for dinner on the day prior to the procedure. The patient must fast for 11 hours prior to ingesting the capsule.

If recommended by the physician, the patient may take a laxative prior to the procedure.

DO NOT smoke for at least 12 hours prior to the capsule endoscope procedure.

DO NOT apply body lotion before the procedure.

DO NOT bite the capsule.

Avoid excessive physical activity during the capsule endoscope procedure.

4 hours after ingesting the capsule, patients may have liquid food.

It is recommended to drink mineral water (non-colored liquid)
frequently, so that it may raise the possibility to take much better quality of the image.

- When undergoing the capsule endoscopy procedure, DO NOT make physical contact with another person undergoing the same procedure.
- During operation of the receiver, DO NOT touch the receiver, or get the receiver wet.
- Only use the provided batteries, and never remove the battery from the receiver during the procedure.
- During upload of the data recorded in the receiver to the workstation, avoid disconnecting the USB. This may damage the patient's data.
- Always confirm that the USB is connected by checking the Receiver screen on the MiroView™ software.
- Always check the AC Power range before use the workstation.
- DO NOT touch AC Power code with wet hands.
- DO NOT open the receiver bag or touch receiver outside of the hospital.
- This device is intended for patient over the age of 18.

⚠️ WARNING  The Capsule takes a picture for 11 hours and gets naturally excreted in about 24 hours under normal conditions. If the capsule has not been excreted from the patient within 72 hours, patient should contact the physician. After examining, the physician may need to perform a surgical operation or treatment to remove the capsule.

⚠️ WARNING  Before moving the system, always make sure to disconnect the monitor from the main system, and then safely move the main system and monitor separately. Connect the main system and monitor only after the hardware is fully installed, secure and stable.
1.4.3  Cleaning and Maintenance

- **System and accessories**
  - All products should be cleanly maintained. For cleaning, rub them lightly with a soft cloth wet with warm water at least once a week. Do not use organic solvents such as lacquer, thinner, ethylene and oxide because they can damage the equipment. Be careful that foreign substances do not enter the main system when cleaning.
  - ALWAYS operate the equipment under sanitary environmental conditions. DO NOT use heat or gas for disinfection of the capsule.

- **Service Document**
  If required, or upon request, the local IntroMedic Distributor (authorized IntroMedic Representative) may provide block diagrams, lists of spare parts, descriptions, adjustment instructions or other related information which may help qualified technical personnel in repairing specified parts of the equipment which have been defined repairable by IntroMedic Co., Ltd.

- **Moving the Equipment**
  - CAUTION when moving equipment.
  - WARNING: Excessive impact/shock causes internal damage.
  - If wiring is connected/disconnected when moving, check the exact wiring status after moving.
  - If damage to the equipment is discovered after moving, immediately contact IntroMedic or local Distributor.
Overview & Intended Usage
2. SYSTEM OVERVIEW

MiroCam® is an orally ingested capsule endoscope designed to capture and wirelessly transmit images of the lining of the small intestine. Captured images are viewed via the MiroView™ software for diagnosis of diseases related to the small intestine.

The MiroCam® capsule endoscope system consists of the MiroCam® capsule, MiroCam® receiver, MiroView™ software, and accessories.

2.1 Intended Purpose

MiroCam® is intended for visualization of the small bowel mucosa as an adjunctive tool in the detection of abnormalities of the small bowel. The device captures images of the small bowel with a wireless camera contained in a capsule. This device includes an ingestible capsule (containing a light source, camera, transmitter, and battery), an electrode array, a receiving/recording unit, a data storage device, computer software to process the images (MiroView™), and accessories.
2.1.1 Contraindications

- Not intended for patients with known or suspected gastrointestinal tract obstructions, perforations, strictures or fistular.
- Not intended for patients who have difficulty ingesting food or pills (dysphagia).
- Not intended for patients who have difficulty communicating.
- Not intended for patients with indigestion, or slow gastric emptying.
- Not intended for patients who may be affected by electromagnetic radiation, such as pregnant women, infants, and patients with heart disease or epilepsy.
- Not intended for patients with diverticulosis in the Small Bowel.
- Not intended for patients who are recommended against having the procedure by a Physician.
- Not intended for patients with pacemakers and/or defibrillators.
- This device is intended for patient over the age of 18.

2.2 Observable Diseases

2.2.1 Obscure gastrointestinal bleeding (OGIB)

- Angioectasia
- Meckel diverticulum
- NSAIDs

2.2.2 Crohn's Disease
2.2.3 Small Bowel Tumors

- Polyps
- Peutz-Jeghers Syndrome
- Familial adenomatous polyposis
- Lymphoma
- Carcinoid
- Gastro-Intestinal Stromal Tumor (GIST)
- Lipoma
- Hemangioma

2.2.4 Inflammation

- Intestinal Tuberculosis
- Typhoid Fever
- Angeitis
- Amyloidosis
- Eosinophilic enteritis

2.2.5 Celiac Disease

2.2.6 Behcet’s Disease

2.2.7 Cowden Disease

2.2.8 Cronkhite-Canada Syndrome
2.3 Product Lifetime

2.3.1 Maximum Storage Time of MiroCam® Capsule

- MC1000-C : 1 Year
- MC1000-F : 1 Year
- MC1000-G : 1 Year

2.3.2 MiroCam® Receiver, MR1000

- MiroCam® Receiver Battery : 4.62 Year
Chapter 2
Overview & Intended Usage

2.4 Product Specification

2.4.1 MiroCam® Capsule

- Component

<table>
<thead>
<tr>
<th>Component</th>
<th>Model Name</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capsule</td>
<td>MC1000</td>
<td>1 Piece (Optional)</td>
</tr>
<tr>
<td></td>
<td>MC1000-F</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MC1000-G</td>
<td></td>
</tr>
<tr>
<td>Sensor Pads</td>
<td>MC1000-S</td>
<td>10 Piece</td>
</tr>
</tbody>
</table>

- Specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capsule Unit (MC1000, MC1000-F, MC1000-G)</td>
<td>Size: 11 X 24 mm</td>
</tr>
<tr>
<td></td>
<td>Weight: 3.4 ± 0.05g</td>
</tr>
<tr>
<td></td>
<td>Frame Rate: 3 frame/sec</td>
</tr>
<tr>
<td></td>
<td>Field of View: 150 degrees</td>
</tr>
<tr>
<td></td>
<td>Battery Life: 12 hours</td>
</tr>
<tr>
<td></td>
<td>Pixels: 102,400</td>
</tr>
<tr>
<td></td>
<td>Lighting: 6 LEDs</td>
</tr>
<tr>
<td></td>
<td>Communication Method: Human Communication</td>
</tr>
<tr>
<td></td>
<td>Body Communication</td>
</tr>
</tbody>
</table>
2.4.2 MiroCam® Receiver

- Component

<table>
<thead>
<tr>
<th>Component</th>
<th>Model Name</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiver Unit</td>
<td>MR1100</td>
<td>1 piece</td>
</tr>
<tr>
<td>Battery Pack</td>
<td>MR1100-B</td>
<td>2 piece</td>
</tr>
<tr>
<td>Data Cable</td>
<td>MR1000-D</td>
<td>1 piece</td>
</tr>
<tr>
<td>Receiver Bag</td>
<td>MR1000-G</td>
<td>1 piece</td>
</tr>
<tr>
<td>System Carrying Case</td>
<td>MR1000-A</td>
<td>1 piece</td>
</tr>
<tr>
<td>Battery Charger</td>
<td>MR1000-C</td>
<td>1 piece</td>
</tr>
<tr>
<td>Adaptor</td>
<td>MR1000-T</td>
<td>1 piece</td>
</tr>
<tr>
<td>Power Code</td>
<td>MR1000-P</td>
<td>1 piece</td>
</tr>
<tr>
<td>Measuring Tape</td>
<td>MR1000-M</td>
<td>1 piece</td>
</tr>
<tr>
<td>USB Cable</td>
<td>MR1000-U</td>
<td>1 piece</td>
</tr>
</tbody>
</table>

- Specification

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Receiver Unit (MR1100)</td>
<td>Battery Life</td>
</tr>
<tr>
<td></td>
<td>12 Hours</td>
</tr>
<tr>
<td></td>
<td>Size</td>
</tr>
<tr>
<td></td>
<td>83.5 X 138 X 28 mm</td>
</tr>
<tr>
<td></td>
<td>Weight</td>
</tr>
<tr>
<td></td>
<td>350g(including Battery)</td>
</tr>
</tbody>
</table>
## Overview & Intended Usage

<table>
<thead>
<tr>
<th>Item</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Battery Pack</strong></td>
<td></td>
</tr>
<tr>
<td>(MR1100-B)</td>
<td><strong>Type</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Capacity</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Voltage</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Recharging Time</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Size</strong></td>
</tr>
<tr>
<td><strong>Data Cable</strong></td>
<td></td>
</tr>
<tr>
<td>(MR1000-D)</td>
<td><strong>Channel</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Length</strong></td>
</tr>
<tr>
<td><strong>Receiver Bag</strong></td>
<td></td>
</tr>
<tr>
<td>(MR1000-G)</td>
<td><strong>Size</strong></td>
</tr>
<tr>
<td><strong>System Carrying</strong></td>
<td></td>
</tr>
<tr>
<td>Case(MR1000-A)</td>
<td><strong>Size</strong></td>
</tr>
<tr>
<td><strong>Battery Charger</strong></td>
<td></td>
</tr>
<tr>
<td>(MR1000-C)</td>
<td><strong>Power Source</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Size</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Weight</strong></td>
</tr>
<tr>
<td><strong>Adaptor</strong></td>
<td></td>
</tr>
<tr>
<td>(MR1000-T)</td>
<td><strong>Weight</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Power Rating</strong></td>
</tr>
<tr>
<td><strong>Power Code</strong></td>
<td></td>
</tr>
<tr>
<td>(MR1000-P)</td>
<td><strong>Length</strong></td>
</tr>
<tr>
<td><strong>Measuring Tape</strong></td>
<td></td>
</tr>
<tr>
<td>(MR1000-M)</td>
<td><strong>Length</strong></td>
</tr>
</tbody>
</table>
2.4.3 MiroCam® Software

- Component

<table>
<thead>
<tr>
<th>Component</th>
<th>Model Name</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>MiroView™ Workstation</td>
<td>MiroView™</td>
<td>2.5</td>
</tr>
<tr>
<td>MiroView™ RTV</td>
<td>MiroView™ RTV</td>
<td>1.0</td>
</tr>
<tr>
<td>Wireless MiroView™ RTV</td>
<td>Wireless MiroView™ RTV</td>
<td>1.0</td>
</tr>
</tbody>
</table>
Performing Capsule Endoscopy
3. PERFORMING CAPSULE ENDOSCOPY

3.1 General Comments

- This chapter describes how to operate and control MiroCam® capsule endoscope system.
- Installation and initial operation must be done by an Authorized IntroMedic Service Technician.

3.2 Safety Warnings

⚠️ WARNING Before turning on the system, check the environment condition for MiroCam® capsule endoscope system.

⚠️ CAUTION In case the system has been brought from cold environment (stock room or airfreight) into a warm room, you should first switch on it after some hours for temperature balance and removing of condensation humidity (Risk of leakage current).

⚠️ CAUTION For the electrical safety, make sure that peripheral equipments (external PC, Monitor, printer etc) should be connected to wall socket of independent power supply with a perfect ground. Particularly make sure whether or not those peripheral equipments should be authorized for medical usage.

⚠️ CAUTION DO NOT touch the dome of the capsule.

⚠️ CAUTION if SIG indicator of the Receiver turns yellow after ingesting the capsule, immediately contact the physician.

⚠️ CAUTION If SIG indicator of the Receiver does not turn green when the patient holds the capsule by the gold bands, immediately stop the procedure.

⚠️ NOTE If images of the small bowel are not captured during the procedure, ensure the capsule has been excreted by the patient and perform procedure again.
3.3 Examination Preparation

The following steps (3.3.1 to 3.3.4) explain the process to initialize the receiver and register patient data for the capsule endoscopy procedure. For more information see section 4.2.

3.3.1 Start System

- Turn on power of MiroCam® workstation.
- Click icon to start the MiroView™ 2.0 Operator.
- Insert the ID and password and click icon.

⚠️ WARNING Before starting the system, check the power rating for the workstation.

3.3.2 Initialize the Receiver

- Connect the smaller connector of USB Cable to Receiver unit.
- Connect normal connector of USB cable to workstation.
- Turn on the power of the Receiver unit.
- Click icon in MiroView™ 2.0 Operator.
- Click icon in MiroView™ 2.0 Operator.
- After completing the required fields, click the button to save the patient information onto the Receiver.
Performing Capsule Endoscopy

3.3.3 Receiver Preparation

- Connect battery to Receiver unit.
  - Insert pins on back side of Receiver unit in the slots on the battery.
  - Press battery to receiver until clasp locks battery in place.
- Turn on power switch of receiver unit.
- Check battery indicator (BAT) of upper side of receiver unit. If battery is fully charged, light will be green. If light is not green, charge the battery.
- Check initialization indicator (INI) of upper side of receiver unit. Prior to beginning a procedure, this light must be green.
- Connect data cable to receiver unit.

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIG</td>
<td>Indicates status of signal from capsule</td>
</tr>
<tr>
<td>Green : Signal is being received from capsule</td>
<td></td>
</tr>
<tr>
<td>Yellow : Signal is not being received from capsule</td>
<td></td>
</tr>
<tr>
<td>INI</td>
<td>Initialization status of Receiver Unit</td>
</tr>
<tr>
<td>Green : Receiver is initialized</td>
<td></td>
</tr>
<tr>
<td>Yellow : Receiver is not initialized</td>
<td></td>
</tr>
<tr>
<td>Battery Status</td>
<td></td>
</tr>
<tr>
<td>Green : Fully charged</td>
<td></td>
</tr>
<tr>
<td>Yellow : Not charged</td>
<td></td>
</tr>
</tbody>
</table>

⚠️ WARNING ⚠️ DO NOT do begin procedure when receiver unit’s battery indicator is not green. This indicates battery is not fully charge or out of order, and patient data may be lost.
3.4 Patient Preparation

Provide the patient with the following instructions to prepare for the capsule endoscope procedure.

3.4.1 Patient Preparation

- **One day prior to the capsule endoscope procedure**
  - Lunch: Patient can have a normal meal around noon, followed by a liquid diet as instructed by the physician.
  - The patient should fast for at least 12 hours prior to the procedure. Patient may only drink water (no food or other beverages such as milk or coffee).
  - The patient should not take any medications two hours before ingesting the capsule endoscope.
  - Male patients may need to shave areas, as advised by the physician or nurse.
  - Patient should stop taking iron supplements 1 week before the capsule endoscope procedure, and should not ingest any medicine at least 2 hours prior to the procedure.
  - Diabetic patients need to follow any changes to insulin dosage as prescribed by the physician.
  - Physician is recommended to prescribe patient a laxative such as PEG or Sodium Phosphate. Patient should ingest laxative 12 hours prior to procedure.
  - Physician is recommended to prescribe patient an anti-foaming agent (such as simethicone), to reduce bubbles in the GI tract. This should be ingested after the laxative.
  - The patient should abstain from smoking 12 hours before the procedure.
  - On the day of the capsule endoscope test, the patient should wear comfortable and loose clothing. One-piece clothing should not be worn.
  - Prior to the procedure, do not apply any lotions or perfumes.

- **On the day of capsule endoscope procedure**
  - After arriving in a hospital at the appointed time, the patient should submit an examination permission form and check in.

- **After ingesting capsule endoscope**
  - The patient should refrain from taking any food or drink two hours after ingesting the MiroCam® capsule endoscope. Water is permitted after two hours.
- The patient can start with light food after 4 hours. When the examination is complete, the patient can start having normal meals.
- In case of any abdominal pain, nausea or vomiting after ingesting the MiroCam® capsule, the patient should contact physician or nurse immediately.

3.5 Sensor Placement & Capsule Ingestion

Following is the detailed procedure required to correctly administer the capsule endoscope procedure.
3.5.1 Connecting Sensor Pads

After attaching sensor pads to the data cables, attach the sensor pad correctly to each area as shown below.
Attach sensor pads according to the number on the data cable.
- Locate the center between the umbilical and the xiphoid process. From this center point, attach the sensor to the distal point on the right flank of the patient's body.
- Place the sensor pad on the xiphoid process line, directly below the right clavicle.
- Place the sensor pad on the xiphoid process line, directly below the left clavicle.
- Locate the center between the umbilical and the xiphoid process. From this center point, attach the sensor to the distal point on the left flank of the patient's body.
- Place the sensor pad on the right pelvic line, 2 cm behind sensor #1.
- Place the sensor on the right inguinal line, 2 cm to the outside of sensor #2.
- Place the sensor on the right inguinal line, 2 cm to the outside of sensor #3.
- Place the sensor pad on the right pelvic line, 2 cm behind sensor #4.
- Place the sensor directly below the right clavicle.

⚠️ **CAUTION** The numbering of the data cables and sensor pad must match the specified area. Please follow the numbering sequence appropriately.

⚠️ **CAUTION** To prevent entanglement of the data cables during procedure, organize cables and place appropriately in cable bag.

⚠️ **WARNING** Correct image signal may not be obtained if a sensor pad is not in direct, immediate contact with the skin. Ensure the sensor pads are in direct contact with the skin. Shaving may be required for male patients.

The pictures below show the sensor pads attached in the correct locations.
3.5.3 Removing Capsule from Packaging

While holding the MiroCam® upside down, peel off the sterilized packaging cover.

3.5.4 Removing the Case

Turn the package over, the MiroCam® case will slip out of the packaging. While holding the MiroCam® case, open the lid.

3.5.5 Removing the Capsule

Grip capsule with right hand, and remove from cast. Do not touch the dome of the capsule.
Make sure that the capsule packaging is not damaged in any way. When removed capsule from case, the capsule should be flashing.

**CAUTION** Do not use a capsule endoscope when the packaging or the capsule is damaged.

Check if the front of the capsule is flashing when it is removed from the case.

After washing hands, patients should grip the gold section of the capsule between the thumb and the forefinger of the both hands.

**NOTE** After turning the receiver power on, if a signal is not received by the receiver within 50 seconds (i.e. the SIG indicator does not turn green), the SIG indicator will flash orange and the receiver will make a ‘beep’ ‘beep’ warning sound. This will occur until a signal is received or the power is turned off. In this case, you must begin the procedure immediately or turn the receiver off until ready to begin the procedure.
3.5.6 Checking Operation of the Receiver and Signal Reception

After the patient holds the capsule as detailed above, the signal indicator on the receiver is green and signal indication melody is generated. If signal indicator is yellow, there is no signal being received from the capsule.

- Switch on the receiver.
- Check if the battery indicator (BAT) at the top of the receiver shows that the battery is fully charged. The battery indicator on the receiver should be green.
- Check if the initialize indicator (INI) at the top of the receiver shows that initialization is complete. The INI indicator on the receiver should be green.
- Connect the data cable to the MiroCam® receiver.
- After patient grasps capsule by opposing gold bands (as detailed in picture above, check the SIG indicator on the receiver is green and signal indication melody is generate.

⚠️ CAUTION If the battery indicator on the receiver shows that the battery is not fully charged, do not start the endoscopy procedure. The battery may be depleted during the procedure and images may not be saved properly.

⚠️ CAUTION Please be noticed to confirm the shape and the direction of the connector when you connect the data cable to MiroCam® Receiver, since it may cause cable damage problem.
3.5.7 Ingesting the Capsule

After checking if the signal indicator on the receiver is green, ingest the capsule with water.

⚠️ CAUTION Do NOT bite the capsule while ingesting.
3.5.8 Checking and Wearing the Receiver

- After ingesting the capsule, make sure that the SIG indicator is green.
- Place the receiver in the bag.
- Organize the contents of the bag so that the cables are not entangled.
- Adjust cables, and place excess in cable bag.
- Adjust the bag strap as needed.

Capsule endoscopy procedure will be complete after 11 hours.

⚠️ CAUTION Patient should not touch receiver during the procedure. This may lead to loss of image data.

⚠️ CAUTION During the procedure the SIG indicator should be green. In this case, check data cable to ensure it is securely inserted and check the sensor pads to ensure these are fixed to the body.
3.6 Uploading Images

Once the capsule endoscopy procedure is complete, upload image data from the receiver to the workstation and start diagnosis of the data using MiroView™ 2.0 Software.

3.6.1 Transferring and Checking image data

- Switch on the workstation.
- Click the icon on the desktop to launch MiroView™ 2.0 Operator.
- When the login window appears, enter the user ID and password, and then click the button.
- Connect the smaller end of the USB cable to the receiver.
- Connect the other end of the USB cable to the workstation.
- Click the button in MiroView™ 2.0 Operator.
- When the image data in the MiroCam® receiver is successfully uploaded, execute MiroView™ 2.0 client to review and report.

⚠️ WARNING For more information on using MiroView™, please refer to Chapter 4, Using MiroView™ 2.0.
3.7 Receiver Management – Post Procedure

3.7.1 Cleaning

- Remove data cable from receiver unit.
- Capsule and sensor pads should not be reused.
- To clean the MiroCam® Receiver unit and Workstation, dampen a soft cloth with warm water or with a commercial, nonabrasive cleaner (or a mild soap or detergent solution) and wipe the exterior surface lightly. Do not allow any liquids to come in contact with the power connector, cable connector or switches. Do not allow any liquids to penetrate connectors or openings in the system cover. Cleaning of the system and accessories should be conducted at least once a week.

⚠️ CAUTION Do not immerse the MiroCam® capsule endoscope system or its accessories in liquid or clean with caustic or abrasive cleaners. Do not spray or pour any liquid on the system or its accessories. Do not use the organic solvents such as a lacquer, thinner, ethylene and oxide because they can damage the equipment. When cleaning the data cables, do not use the cleaning tools such as brush and sandpaper.

3.7.2 Charging Battery

- Battery must be recharged after every procedure.
- Battery can be individually recharged or with receiver unit.
- Battery must be recharged in battery charger.
- If two batteries are inserted in charger, the batteries will automatically consecutively charge (not simultaneous).
Connect adapter DC cable to battery charger.

Connect AC power code to adaptor.
Connect AC power code to AC consent or multi-tap.
Battery charger indicator lights:
- Battery is charging when green light is blinking
- Battery is fully charged when light is solid blue
- Battery is not-charging if light is yellow
- Note: second battery in charger will automatically begin charging once first battery is fully charged.
WARNING If the indicator on the battery charger is blinking yellow there is a bad connection. Please disconnect the battery from the battery charger and try again.

WARNING Only use batteries provided by IntroMedic. Usage of inappropriate batteries can cause serious damage to the receiver.

WARNING Recharge the MiroCam® receiver batteries with the adaptor and the battery charger only from IntroMedic. Improper adaptors and battery chargers cause serious damage.
WARNING Try not to contact the metallic terminal board of batteries with conductive objects or human body. It can cause an electric shock or damage and/or breakage of the batteries.

WARNING Do not use the batteries with visible surface damage on. Usage of damaged batteries can result in leakage of contents of the batteries.

WARNING To avoid the risk of explosion, keep batteries away from fire.

WARNING Treat the batteries carefully from serious impact or shock. This can cause serious damage to the batteries.

WARNING Do not expose the batteries to liquids. This can cause serious damage.
Using MiroView™
4. USING MIROVIEW™

MIROVIEW™ is a computer software program that aids in diagnosis of disease of the small bowel via displaying images obtained from the MiroCam® capsule.

MIROVIEW™ version 2.5 is an update to the MIROVIEW™ version 1.0. The updated functionalities and user interface further enhance the efficiency and effectiveness of the MiroCam® capsule endoscopy procedure.

Following is a list of new & updated features:

- User Interface
  - MIROVIEW™ enables adjustable resolution, to appropriately fit to the screen size.
  - MIROVIEW™ has been designed with a dark background to reduce eye strain.
  - MIROVIEW™ provides intuitive and unified icons so that the user can adapt quickly.

- Reporting Tool
- Express View
- Range View
- Network Support
- Account Management
- Multi-Review / Report Generation Support
- Multi-Receiver Management Support

The workstation where the MIROVIEW™ is installed properly has icons for four applications on the Desktop folder: MIROVIEW™ Client, MIROVIEW™ Operator, MIROVIEW™ Server, and MIROVIEW™ Viewer. However this manual will not explain how to use the MIROVIEW™ Viewer. For additional information for MIROVIEW™ Viewer, please refer to the MIROVIEW™ Viewer Instruction Manual. To get the installation procedure for MIROVIEW™, refer to the MiroCam® Service Manual.
Chapter 4

Using MiroView™

MiroView™

Client

This program is used for reviewing the images from the MiroCam® capsule and generating a patient report. The MiroView™ Server should be started prior to starting the MiroView™ Client.

MiroView™

Operator

This program is used for managing the receivers (initialize, upload etc.) and managing user accounts. The MiroView™ Server should be started prior to starting MiroView™ Operator.

MiroView™

Server

The server stores the patient data files. Start the MiroView™ Server prior to starting MiroView™ 2.0 or MiroView™ Operator.

MiroView™

Viewer

The MiroView™ Viewer is used for reviewing the images exported from the MiroView™ Software; EXMIF or JPEG images.

Functions:
- List Mode
- Review Mode
- Report Mode
- Export Mode
- Image Atlas
- SGBP
  - (Suspected GI Bleeding)
- Positioning Window
- Network connectivity
- Multi-Review
- Express View
- Range View
- Map View
- GI Dictionary
- Finding / Diagnosis Information

Functions:
- Input Patient Information
- Receiver Initialization
- Upload Data from Receiver
- Data Backup
- Account Management
- Network connectivity

Functions:
- DB, Mass storage
- Network connectivity

Functions:
- Study Information
- Image Information
- Show Findings / Diagnosis
4.1 MiroView™ H/W Specifications

4.1.1 MiroView™ Server

- Minimum Hardware Requirements
  - OS: Windows Vista Business
  - CPU: > Core 2 Duo E6300
  - Memory: > DDR II 4GByte
  - Video Card: Windows Compatible
  - HDD: SATA 500GB
  - ODD: DVD+-RW
  - Monitor Resolution: 1024x768

- Recommended Hardware Requirements
  - OS: Windows Vista Business
  - CPU: > Core 2 Duo E6300
  - Memory: > DDR II 4GByte
  - Video Card: Windows Compatible
  - HDD: SATAII RAID 1TB
  - ODD: DVD+-RW
  - Monitor Resolution: 1680x1050

4.1.2 MiroView™ Client

- Minimum Hardware Requirements
  - OS: Windows XP, Vista or Windows7
  - CPU: Pentium4 2 Ghz
  - Memory: 1GB
  - Video Card: GeForce 7600GT 128MB
  - HDD: SATA 160GB
  - ODD: DVD+-RW
  - Monitor Resolution: 1024x768
  - Sound Card / Mike / Speaker

- Recommended Hardware Requirements
  - OS: Windows XP, Vista or Windows7
4.1.3 MiroView™ Operator

- **Minimum Hardware Requirements**
  - OS: Windows XP, Vista or Windows7
  - CPU: Pentium4 2 Ghz
  - Memory: 1GB
  - Video Card: Windows Compatible
  - HDD: SATA 160GB
  - ODD: DVD+-RW
  - Monitor Resolution: 1024x768

- **Recommended Hardware Requirements**
  - OS: Windows XP, Vista or Windows7
  - CPU: > Core 2 Duo E6300
  - Memory: 1GB
  - Video Card: Windows Compatible
  - HDD: SATA 160GB
  - ODD: DVD+-RW
  - Monitor Resolution: 1024x768

4.1.4 MiroView™ Viewer

- **Hardware Requirements**
  - OS: Windows XP, Vista or Windows7
  - CPU: Pentium4 2Ghz
  - Memory: 1GB
  - Video Card: Windows Compatible
  - HDD: SATA 160GB
  - ODD: DVD+-RW
  - Monitor Resolution: 1024x768
CAUTION MiroView™ cannot be viewed on a monitor with a resolution under 1024x768.

NOTE The GUI is best viewed on a wide monitor of 19” or larger.
4.2 Overview – MiroView™ Server

The MiroView™ Server software is intended to be used as a system administrative managing tool. The MiroView™ Server manages file systems and database systems. When powering up the workstation, MiroView™ Server will start automatically. If the following window appears, please set up the configuration for the first run.

- Set the port number for the Network. If unknown, please leave this field as ‘2000’. This field should be managed by your Network Administrator in your hospital.
- Set the password for ‘Administrator’ account. Additional accounts can be made via Account Manager function, after logging on the MiroView™ Operator as ‘Administrator’.
- Confirm the password.
- Type the Hospital Name.
Type the Address that should appear on the Capsule Endoscope Report.
Type the Telephone Number that should appear on the Capsule Endoscope Report.

After setting up the Configuration Windows, MiroView™ Server window above will appear. Click the icon to hide the window.
4.3 Overview - MiroView™ Operator

MiroView™ Operator software is intended to be used for administrative purposes, including account and receiver management.

4.3.1 Start MiroView™ Operator

- Double click the icon to run the MiroView™ Operator. When executed for the first time, the following window will appear.

  ![Config Window]

- Input “127.0.0.1” for the IP Address and “2000” for the Port.
- Direct the “Local File Path” to the caching folder and choose the preferred Language settings and press \[\text{finish}\] button to access MiroView™ Operator.
- After MiroView™ Operator has launched, the Log-in window will appear.
Input ‘Administrator’ for ID and password. Then press the button.

**CAUTION** ID and password are encrypted. Do not forget the ID and password.

**CAUTION** Before MiroView™ Operator has launched, you must create the password for the administrator account. When running the MiroView™ Server for first time, the user must create the password for the administrator account.

**NOTE** You can create new and edit existing accounts by using the Account Management tool on MiroView™ Operator.
The following subsections describe the main interfaces and functions of the MiroView™ Operator.

### 4.3.2 List Mode

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>List Mode</td>
</tr>
<tr>
<td>2</td>
<td>Receiver Mode</td>
</tr>
<tr>
<td>3</td>
<td>Print Report</td>
</tr>
<tr>
<td>4</td>
<td>Recycle Bin</td>
</tr>
<tr>
<td>5</td>
<td>Export</td>
</tr>
<tr>
<td>6</td>
<td>Search</td>
</tr>
<tr>
<td>7</td>
<td>Show all</td>
</tr>
</tbody>
</table>

- **List Mode**: Opens List Mode
- **Receiver Mode**: Opens Receiver Mode
- **Print Report**: Print out the selected Report
- **Recycle Bin**: Open Recycle Bin Window
- **Export**: Export the selected Report
- **Search**: Search Cases and/or Reviews by keyword
- **Show all**: Refresh and Show all the Cases and Review on the List
4.3.3 Receiver Mode

Screen enables administration and status display for up to four receivers.

- **Upload**: Upload images in the receiver to the server
- **Input Patient’s Information**: Input Patient’s Information to the selected receiver
- **Initialization**: Delete all data from the receiver and/or prepare the receiver for the next patient.
- **Receiver Port**: Shows the status of the connected receiver for each of the four ports
- **Detail View**: Shows the patient’s information for the selected receiver
4.3.4 Receiver Initialization

Click the button to initialize the selected receiver.
4.3.5 Inputting Patient Information

Click the button to enter the patient information. After completing the required fields, click the button to save the patient information onto the Receiver. The fields in the patient information are editable and additional fields can be added. This can be accessed via Tools → Preferences → Receiver → Set → Add / Modify.

* indicates required fields.
Chapter 4

4.3.6 Data Upload

After the capsule endoscopy procedure, upload the data from the Receiver to the MiroCam® system via MiroView™ Operator. Click the button to upload the data from the Receiver.

After the image data in the MiroCam® Receiver has been successfully uploaded, enter the List Mode and check if the new Case has been created.

- Double click the icon to run MiroView™ Client.
- Select the newly uploaded Case and enter the Review Mode.
- Play the case to check the uploaded image data.

⚠️ CAUTION ⚠️ If you fail to upload the data from the Receiver, disconnect and reconnect the USB cable from the workstation, then turn off the MiroCam® Receiver and turn it back on. Try uploading again. If the problem persists, please contact IntroMedic.

⚠️ NOTE ⚠️ If the user uploads a patient data which has been uploaded before, an error message ‘Data has been previously uploaded. Would you like to upload again?’ will appear.

⚠️ NOTE ⚠️ Upload progress will be displayed. The user can stop the process while uploading by clicking the button.
4.3.7 **User Account Management**

MiroView™ Operator enables management of multiple users & Groups. Users can be organized into Groups to readily control access. The following screen can be accessed by Tools → Account Manager.
Add an account. Click the 
button to show the window as displayed below.

**ID:** User ID  
**Password:** Password  
**Name:** User Name  
**Type:** User type.  
- Super User: can access all the reviews in the System  
- User: can access all the reviews in the Group of the User’s  
- Operator: can log in via MiroView™ Operator S/W only.  
※ Administrator account can log in via both MiroView™ Client and MiroView™ Operator.

**Group:** Set of users in the same Clinic or Laboratory.

### 4.4 Overview - MiroView™ Client

#### 4.4.1 Start MiroView™ Client

- Double Click the 
button to run MiroView™ Client.

- Enter the User ID and password and click the 
button.
4.4.2 List Mode

- List

1. List Mode
2. Review Mode
3. Report Mode
4. Export Mode
5. Print Report
6. Add a Review
7. Delete Case
8. Delete Review
9. Recycle Bin
10. Search
11. Show all
12. Selection Bar
13. Detail View

- Open List Mode
- Open Receiver Mode
- Open Report Mode
- Open Export Mode
- Print selected Report
- Add a Review for the Selected Case
- Delete selected Case
- Delete selected Review
- Open Recycle Bin
- Search Cases and/or Reviews by key word
- Refresh and Show all the Cases/Reviews on the List
- A rectangular area to show selected item
- Show Detail Information for selected Case or Review
4.4.3 Review Mode

Select a case to review on the List Mode and click the icon to enter the Review Mode.

Capture Box Mode

1. List Mode
2. Review Mode
3. Report Mode
4. Export Mode
5. Positioning Window
6. Single View
7. Dual View
8. Tri View
9. Range View
10. Normal View

- List Mode: Open List Mode
- Review Mode: Open Review Mode
- Report Mode: Open Report Mode
- Export Mode: Open Export Mode
- Positioning Window: Current position of the capsule in 2D
- Single View: Change to Single View
- Dual View: Change to Dual View
- Tri View: Change to Dual View
- Range View: Change to Quad View
- Normal View: Shows all images taken by the Capsule
<table>
<thead>
<tr>
<th></th>
<th>Express View</th>
<th>Actively removes images based upon similarity; effectively reducing the number of images for review. This mode is recommended to review the patient file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>SGiB</td>
<td>Shows images that have high possibility of bleeding and / or blood. This mode may assist in finding areas of suspected bleeding; however, it is NOT 100% reliable, and should only be used as an adjunctive tool to assist in reviewing the images.</td>
</tr>
<tr>
<td>3</td>
<td>Previous Image</td>
<td>Go to Previous Image</td>
</tr>
<tr>
<td>4</td>
<td>Previous Capture</td>
<td>Go to Previous Capture</td>
</tr>
<tr>
<td>5</td>
<td>Play Backward</td>
<td>Play Backward</td>
</tr>
<tr>
<td>6</td>
<td>Pause / Resume</td>
<td>Pause / Resume</td>
</tr>
<tr>
<td>7</td>
<td>Play Forward</td>
<td>Play Forward</td>
</tr>
<tr>
<td>8</td>
<td>Next Capture</td>
<td>Go to the Next Capture</td>
</tr>
<tr>
<td>9</td>
<td>Next Image</td>
<td>Go to the Next Image</td>
</tr>
<tr>
<td>10</td>
<td>Capture</td>
<td>Image capture button.</td>
</tr>
<tr>
<td>11</td>
<td>Landmark</td>
<td>Set landmarks for transition points in the GI tract.</td>
</tr>
<tr>
<td>12</td>
<td>Image Enhancement</td>
<td>Alter images characteristics (ie. color, saturation etc.) to assist in identifying abnormalities.</td>
</tr>
<tr>
<td>13</td>
<td>Time Display</td>
<td>Displays the time duration of the capsule from procedure start.</td>
</tr>
<tr>
<td>14</td>
<td>Zoom View</td>
<td>Fit image to full screen</td>
</tr>
<tr>
<td>15</td>
<td>Comparison Window</td>
<td>Displays the image selected from the Image Atlas.</td>
</tr>
<tr>
<td>16</td>
<td>Thumbnail Extension</td>
<td>Extends the Capture Box to display all captured images.</td>
</tr>
<tr>
<td>17</td>
<td>Capture Box</td>
<td>Toggle the Capture Box to Thumbnail and Finding Summary Box</td>
</tr>
</tbody>
</table>
Finding Summary Box

Toggle the Capture Box to Thumbnail and Finding Summary Box. Initially, a captured image will be classified as a generic ‘capture’. A user may classify a finding through the reporting tool Auto-Finding Checker, which will then appear in the appropriate category in the Finding Summary Box (if it is one of the major categories).
■ Mode Control

- Zoom View

Click the icon to change to Zoom View mode

NOTE Play Slide Control is available on the Zoom View mode to set playing direction and speed.

NOTE Move the cursor away from the bottom of the screen and the Play Control will appear.
Viewing Modes

Select one of the icons for preferred Viewing Mode.

- Single View
- Dual View
- Quad View
- Range View

NOTE  Range View has been designed to assist in readily finding transition points in the GI tract. The display will show 9 images before and 9 images after the current position. The 9 images are defaulted to 10 minutes apart, resulting in an overview of 90 minutes prior to, and 90 minutes after the current position. The number of images displayed is set at 9, and is not configurable. The 90 minute duration is configurable and can be adjusted by clicking and dragging the mouse icon on the time boundary.
Map View

This view has been designed to assist in findings by showing all the images on the same page like a wall paper. You can move the cursor on the designated image to see the original image in detail.

Normal Mode

Express Mode

SGIB Mode

The icons will change to playing Mode, as detailed below.
## Activated Windows

### - Positioning Window

Displays the location of where the capsule took the current image.

### - Comparison Window

Displays the image selected from the Image Atlas.

### - Image Enhancement Window

Alter images characteristics (ie. color, saturation etc.) to assist in identifying abnormalities.
4.4.4 Report Mode

Select the desired review for the Case from the List Mode and click the icon to move to the Report Mode.

- Report Mode

![Diagram of Report Mode with numbered icons and descriptions]

<table>
<thead>
<tr>
<th>Number</th>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>List Mode</td>
<td>Open List Mode</td>
</tr>
<tr>
<td>2</td>
<td>Review Mode</td>
<td>Open Review Mode</td>
</tr>
<tr>
<td>3</td>
<td>Report Mode</td>
<td>Open Report Mode</td>
</tr>
<tr>
<td>4</td>
<td>Export Mode</td>
<td>Open Export Mode</td>
</tr>
<tr>
<td>5</td>
<td>Scale</td>
<td>Opens graduated scale for display on the image</td>
</tr>
<tr>
<td>6</td>
<td>Drawing Tools</td>
<td>Enables users to include annotations for the image.</td>
</tr>
<tr>
<td>7</td>
<td>Image Enhancement</td>
<td>Alter images characteristics (ie. color, saturation etc.) to assist in identifying abnormalities.</td>
</tr>
</tbody>
</table>
### Chapter 4

**Using MiroView™**

<table>
<thead>
<tr>
<th></th>
<th>GI Dictionary</th>
<th>Provides the frequently-used-words to search.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Text Comments</td>
<td>Write comments for the Capture on the main display and the report. (Image Comments, Reason for Referral, Procedure info &amp; findings, Summary &amp; Recommendation)</td>
</tr>
<tr>
<td></td>
<td>Audio Comment</td>
<td>Record voice comments (The user can record min 3 sec ~ max 300 sec for each Capture)</td>
</tr>
<tr>
<td>11</td>
<td>Input Word</td>
<td>Input the selected word into the text editor.</td>
</tr>
<tr>
<td>12</td>
<td>Add Word</td>
<td>Add the typed word into the Dictionary.</td>
</tr>
<tr>
<td>13</td>
<td>Delete Word</td>
<td>Delete selected word from the Dictionary.</td>
</tr>
</tbody>
</table>

**NOTE** Additional tabs in the report can be created or modified via Tools -> Preferences -> Report
4.4.5 Export Mode

- List Mode: Open List Mode
- Review Mode: Open Review Mode
- Report Mode: Open Report Mode
- Export Mode: Open Export Mode
- Check Captured Image: Select Captured image and add to the list to print/export.
- Uncheck Captured Image: Deselect Captured image and remove from the candidate list to print/export.
- Print: Print out the report for the Review.
- Preview: Preview the report
- Save as PDF: Save the report as a PDF file.
- Export Review: Export Review data only without Video. Review data is the own format of MiroView™, which
<table>
<thead>
<tr>
<th></th>
<th>Send to PACS</th>
<th>Contains Captured Images and Comments by the user. Send selected captured images to PACS system via DICOM Sender</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>Export EXMIF</td>
<td>Export Captured Images as EXMIF (eXchangeable Medical Information Format)</td>
</tr>
<tr>
<td>13</td>
<td>Export</td>
<td>Export Captured Images as Image, Video, or MiroVideo. MiroVideo is the own video format for MiroView™.</td>
</tr>
<tr>
<td>14</td>
<td>Export Segment</td>
<td>Export segment as Video, MiroVideo</td>
</tr>
<tr>
<td>15</td>
<td>Export Entire</td>
<td>Export entire file as Video, MiroVideo</td>
</tr>
</tbody>
</table>
4.5 Overview - MiroView™ Viewer

4.5.1 Start MiroView™ Viewer

- Double Click the button to run MiroView™ Viewer. Open an Image File (EXMIF-Exchangeable Medical Image Format data or JPEG) via ‘File -> Open’ function.

![Diagram of MiroView™ Viewer interface]

<table>
<thead>
<tr>
<th></th>
<th>Image Display</th>
<th>Image Display Area (EXMIF or JPEG)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Title</td>
<td>Title for the image in the Image Display</td>
</tr>
<tr>
<td>2</td>
<td>Description</td>
<td>Description for the image in the Image Display</td>
</tr>
<tr>
<td>3</td>
<td>Study Information</td>
<td>General Information (Software / Manufacturer / Hospital Information), Patient Information (Doctor, Patient Body Shape) and Study Information (Doctor, Receiver, Capsule and Procedure Information) for the image in the Image Display</td>
</tr>
<tr>
<td>4</td>
<td>Image Information</td>
<td>Creator Information and/or Finding Comments for the image in the Image Display</td>
</tr>
<tr>
<td>5</td>
<td>Findings</td>
<td>Findings information the creator captured and commented before for the image in the Image Display</td>
</tr>
<tr>
<td>6</td>
<td>Diagnosis</td>
<td>Diagnosis information the creator captured and commented on for the image in the Image Display</td>
</tr>
</tbody>
</table>
4.6 Performing Capsule Endoscopy

4.6.1 Initializing Receiver

- Connect the Receiver to the workstation via USB port.

- Run the MiroView™ Operator by double clicking the icon on the desktop or from the Windows Start-up menu. Log in.

- Enter the Receiver mode and select the Receiver port to initialize.
Click the icon. The following message will appear.

Click ‘Yes’ to start the initializing process.

After the initializing process is complete, the following message will appear.
Click ‘OK’ and the Patient Information window will appear. Input the patient information for each field.

Click ‘Check Name’ button to input the patient name and then click the ‘Check Doctor Name’ button to input the doctor name.

(The fields marked with * is required.)

Click to save the Patient Information to the Receiver. The Receiver is now ready for the procedure.

NOTE The fields in the patient information are editable, and additional fields can be added. This can be accessed via Tools → Preferences → Receiver → Set → Add / Modify.
4.6.2 Upload Data (MiroView™ Operator)

- Connect the Receiver to the workstation via USB port.

- Run the MiroView™ 2.0 Operator by double clicking the icon on the desktop or from the Windows Start-up menu. Log in.

- After switching the Receiver on, enter the Receiver mode and select the proper Receiver port to upload the patient file.
Chapter 4  Using MiroView™

- Click the button to start the Upload.

![Image of MiroView™ interface during upload]

- After completing the Upload, the following message will appear.

![Image of upload complete message]

4.6.3 Review (MiroView™ Client)

- Run MiroView™ Client by double clicking the icon on the desktop or from the Windows Start-up menu. Log in.

![Image of MiroView™ login screen]

*If you want to run the MiroView™ Client as Local Mode, click ‘Local’ button on the Log-in screen.*
■ Select the Patient Video Data on the List Mode
- Select a patient video data to review from the List Mode and click the icon to enter the Review Mode.
- Check to see if another user is reviewing the patient file on the Current User column in the List Mode.

- If the patient file is being reviewed by another user, a message will appear.
Review the Patient Video on the Review Mode

**NOTE** For efficient video playback the video is cached locally in the server. During this buffering process, the video may be reviewed.

– Click the 'Range View' icon to readily set landmarks.
- Use the Range View and Normal View to find all the landmarks.

![Image]

**NOTE** Click the landmark icon and select landmark type: Esophagus, Gastric, Duodenum, IleoCecal, and Cecal.

- After marking the necessary landmarks, play the video via the Express mode and capture abnormalities and / or suspected disease pathologies in the small bowel.

![Image]
NOTE  The user can press ‘Enter’ key to capture the image.

- To identify abnormalities and/or disease pathology more easily, use the Image Enhancement function to adjust preferred image settings. Click the icon to open the Image Enhancement window.
Composing the Report on the Report Mode

- After capturing images of suspected disease in the Review Mode pathology, click the icon to enter the Report Mode.

- Use the auto complete dictionary slide and choose available disease pathology from the list.

- Completing the report:
  1. Complete image comments for captured images (as required)
  2. Complete the following tabs: Reason for referral; Procedure Info & Findings; and Summary & Recommendations
  3. After completing the report, enter the Export Mode to print out the complete report and/or export MiroView™ 2.0 data.
NOTE The GI Dictionary tab and findings tab allow the user to adjust the findings and the level of severity. The user can use the GUI easily.

CAUTION Do not detach and/or attach the Microphone from/to the workstation while recording the audio comment.

CAUTION Sound Card Driver must be installed prior to using the Recording function.

CAUTION Prior to recording the comments, close all the applications using the Sound Card such as music/video player.
- Print report, create file and export the Review on the Export Mode.

- Select the images to select and click button to add the selected captured images to the candidate list to export. (You can remove the selected images from the candidate list using the button)
- Click the button to use export function. A window will appear like below.

![Export Captured Images](image)

- Select the File Type to export and change the desired file location on the Selected Folder and click the button. A window will appear with a progress bar.

![Task Manager](image)
- The user can use the button for EXMIF, the button for Segment Export (Video / Miro Video) and the button for Export Case function.

NOTE Select the segments on the Timebar to export. If no segment is selected, the button to export segments would be disabled.

NOTE MiroVideo includes Reviews and selected Segments so that the user can confirm the contents and edit from ‘Open Case / Review file…’, ‘Import Case / Review file…’ main menu.
Print Report and save the report as PDF on the Report Preview
- Click the icon to print reports and/or click the icon to save the report as PDF.
- Show report preview on the screen.

- The user can print out the report and save the report to PDF file in this screen.
- If the user selects the 6 images or 9 images per page mode and tries to print out, the message ‘If you proceed with the current Layout mode, image comments may be omitted and not printed. Please select another Layout Mode to include all comments in the report.’ will appear.
4.6.4 Image Atlas

- Atlas

Reference images are searchable by **Capsule Endoscopy**

**Structured Terminology (CEST)**, Endoscopy 2005; 37: 951 - 959

(February 16, 2002 © Given Imaging Ltd.)

<table>
<thead>
<tr>
<th></th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Atlas Default Atlas Images</td>
</tr>
<tr>
<td>2</td>
<td>My Atlas Atlas Images configured by the user</td>
</tr>
<tr>
<td>4</td>
<td>Import Atlas Images from file Import Atlas Images from file; BMP, JPEG, GIF, EMF, WMF, TIFF and PNG file format.</td>
</tr>
<tr>
<td>5</td>
<td>Export Atlas Images to file Export Atlas Images to file; BMP, JPEG, GIF, EMF, WMF, TIFF and PNG file format.</td>
</tr>
<tr>
<td>6</td>
<td>Edit Information Edit the Information for the selected Atlas Image.</td>
</tr>
<tr>
<td>7</td>
<td>Export Atlas Image(s) to E-mail Export Atlas selected Atlas Image(s) and sends it / them to another doctor via E-mail.</td>
</tr>
</tbody>
</table>
### Chapter 4

#### Using MiroView™

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Delete Atlas Image(s)</td>
<td>Delete the selected Atlas Image(s)</td>
</tr>
<tr>
<td>9</td>
<td>Print Atlas Image(s)</td>
<td>Print the selected Atlas image(s)</td>
</tr>
<tr>
<td>10</td>
<td>Save as PDF</td>
<td>Save the selected Atlas Image(s) as PDF</td>
</tr>
<tr>
<td>11</td>
<td>Show/Hide Marks</td>
<td>Show / Hide Marks on the Atlas Image(s)</td>
</tr>
<tr>
<td>12</td>
<td>Search</td>
<td>Search the Atlas Image</td>
</tr>
<tr>
<td>13</td>
<td>Comparison Window</td>
<td>Show the Comparison Window</td>
</tr>
<tr>
<td>14</td>
<td>Browser Tab(Findings / Diagnosis)</td>
<td>Area where to select the Category of the Atlas Image to see.</td>
</tr>
<tr>
<td>15</td>
<td>Recent Images</td>
<td>Images that the user saw on the Comparison Window</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Image Information</strong></td>
<td>Show the Information for the Atlas Image</td>
<td></td>
</tr>
<tr>
<td><strong>Findings / Diagnosis</strong></td>
<td>Show the Findings / Diagnosis Information</td>
<td></td>
</tr>
<tr>
<td><strong>Atlas Thumbnail Area(2)</strong></td>
<td>Search the Atlas Image</td>
<td></td>
</tr>
</tbody>
</table>

Comparison Window

Show the Current Image and Comparison Image at once.
- Import Atlas Images from file(s)

MiroView™ allows the user to import image files for personal purpose.

- Click the icon to open the ‘Open’ Browser to look for the files to import.
- Select the file to import and click ‘Open’

- Complete the ‘Title’, ‘Description’ and ‘Image Information’ fields and click ‘OK’.
4.7 How to import MiroView™ 1.0 files

4.7.1 Preparing files for import

- Run the MiroView™ 1.0
- Export files by clicking ‘Export for MiroView Express’ function on MiroView™ 1.0

Before using the Export to MiroView Express function, you must insert DVD media to the DVD writer or connect the external hard disk or USB flash memory to the workstation via USB port.

1. Select a patient file from the list to export to MiroView Express.
2. Execute ‘Export to MiroView Express…’ on the main menu
3. If the form, ‘Save As’ appears like below, select the location to export and fill in the ‘File name’ field and click ‘Save’.

4. The window appears like below and if the function ends successfully you will see the message, “Exporting has been completed.”
4.7.2 Import MiroView 1.0 files

- Run the MiroView™ 2.0 Operator or MiroView™ 2.0 Client.
- Execute the 'Import Case / Review File… -> Import Case’ in the ‘List’ menu
Select MiroView™ 1.0 files from the file extension drop-down box and look for the file to upgrade.

Look for the File with extension `.MiroCam` and click `Open`
Task Manager will appear and will proceed with importation of the file. If the Doctor name on the file is not registered on the MiroView™ 2.0 Server, ‘Doctor in charge’ registration process will start.
• If the Reviewer name on the file is not registered on the MiroView™ 2.0 Server, ‘Reviewer’ registration process will start.

• Complete necessary fields and click ‘OK’.
Progress bar will appear.

Upgrading MiroView™ 1.0 file to MiroView™ 2.0 file will be completed.
Using MiroView™ RTV
5. USING MIROVIEW™ RTV

MiroView™ RTV, the application software for the MiroCam® System Real-time Viewer, consist of a data transmission module that directly receives the image data from the MiroCam® Receiver and an output module for image display.

5.1 Overview

MiroView™ RTV software can be installed on any mobile platform. Click the corresponding icon on the desktop to launch the MiroView™ RTV.

5.1.1 Basic Screen Layout

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>①</td>
<td>Name / ID / Gender / Age</td>
</tr>
<tr>
<td>②</td>
<td>Start / Pause / Resume</td>
</tr>
<tr>
<td>③</td>
<td>Main Display</td>
</tr>
<tr>
<td>④</td>
<td>Time Display</td>
</tr>
</tbody>
</table>

① Patient Information: Display patient name, ID, gender and age
② Operation Button: Change MiroView™ RTV operation status between start, pause and resume.
③ Main Display: Display captured image.
④ Time Display: Indicates the MiroCam® capsule endoscope procedure time.
5.1.2 Basic Mobile PC Layout

1. USB Port  
   USB Port for connect with MiroCam® Receiver
2. DC-Jack  
   Connector for Mobile PC Charger
3. Power Switch  
   Mobile PC Power on switch.

⚠️ **WARNING**  Only recharge the mobile PC batteries when MiroCam® Receiver does not connect to the mobile PC.

⚠️ **WARNING**  For safe use of mobile PC, please refer to mobile PC User Manual.
5.1.3 Recommended Hardware Specification

- Operating System: Windows XP Professional
- CPU: A110 800Mhz
- Memory: DDR II 1GByte (667MHz)
- Display Adaptor: Windows Compatible
- Hard Disk: Over 1GB
- Monitor Resolution: 1024x600
- Monitor Contrast: Windows Compatible
- In compliance with IEC60950-1 or IEC60601-1
5.2 Using MiroView™ RTV

5.2.1 Before Using MiroView™ RTV

- The MiroView™ RTV software is pre-install on mobile PC

⚠️ **WARNING** Do not use MiroView™ RTV software and mobile PC before upgrading the MiroCam® Receiver.

⚠️ **WARNING** Do not upgrade MiroCam® Receiver during the MiroCam® capsule endoscopy procedure, it may result in loss if image data.

- Connect the data cable for the Real-time Viewer to the MiroCam® Receiver.

⚠️ **NOTE** The data cable for MiroView™ RTV has no cover for the USB port on the MiroCam® Receiver.

- Follow the MiroCam® capsule endoscopy procedure.

⚠️ **NOTE** For more information on the MiroCam® capsule endoscope procedure, please refer to *Chapter 3, Performing Capsule Endoscopy.*
5.2.2 Starting MiroView™ RTV

- Switch on the mobile PC.
- Click the icon on the desktop to launch MiroView™ RTV.
- Connect the small side of the USB cable to the MiroCam® Receiver.

- Connect the large side of the USB cable to the Mobile PC.

- Click the button to start image display
- Click the button to stop image display
- Click the button to restart image display
- Click the button on the top-right to close the MiroView™ RTV.

**NOTE** Start, Pause, and Resume use the same button. The function (Start, Pause or Resume) changes based upon the status of MiroView™ RTV software.

**CAUTION** MiroView™ RTV is not software for to be used for diagnostic purposes. Use the MiroView™ software for viewing the patient images for diagnostic purposes.

**CAUTION** Do not disconnect the MiroCam® Receiver while the RTV is in use. If the MiroCam® Receiver is disconnected during use, the software may need to be restarted.

**NOTE** If an error message appears while using MiroView™ RTV, reconnect the USB cable between MiroCam® Receiver and Mobile PC.
5.2.3 After Using MiroView™ RTV

- Disconnect USB cable from MiroCam® Receiver and mobile PC.

- Continue MiroCam® capsule endoscope procedure.
Using Wireless MiroView™ RTV
6. USING WIRELESS MIROVIEW™ RTV

Wireless MiroView™ RTV, the application software for the MiroCam® System Real-time Viewer, consist of a data transmission module that directly receives the image data from the MiroCam® Receiver and an output module for image display. Wireless MiroView™ RTV receive image data via Wi-Fi channel.

6.1 Overview

Wireless MiroView™ RTV software can be installed on I-OS 3 or I-OS 4 running on I-Pad / I-Phone / I-Pod Touch. Click the corresponding icon on the desktop to launch the Wireless MiroView™ RTV.

6.1.1 Basic Screen Layout – I-Phone / I-Pod Touch

1. ID / Name / Gender / Age
2. Receiver Scan
3. Main Display
4. Time Display
Chapter 6  Using Wireless MiroView™ RTV

6.1.2 Basic Screen Layout – I-Pad

1. Patient Information
   Display patient name, ID, gender and age

2. Receiver Scan Button
   Show the available Receiver Access Points so that the user can choose to see the patient image.

3. Main Display
   Display captured image.

4. Time Display
   Indicates the MiroCam® capsule endoscope procedure time.

NOTE If turning the I-Pad upright as Portrait View, Receiver List will disappear for the Main Display to be enlarged.
Using Wireless MiroView™ RTV

Chapter 5

① Patient Information
   Display patient name, ID, gender and age

② Receiver Scan Button
   Show the available Receiver Access Points so that the user can choose to see the patient image.

③ Main Display
   Display captured image.

④ Time Display
   Indicates the MiroCam® capsule endoscope procedure time.

6.1.3 Recommended Hardware Platform

- I-Phone 3G, 3GS, 4G
- I-Pod Touch 3G
- I-Pad
6.2 Using Wireless MiroView™ RTV

6.2.1 Network configuration for Wireless MiroView™ RTV

- The Wireless MiroView™ RTV software is pre-installed on I-OS 3 / I-OS 4 running on I-Phone, I-Pod Touch or I-Pad.

⚠️ NOTE When the Wireless MiroView RTV run first, network configuration for I-Phone and I-Pad is required.

- Fallow the MiroCam® capsule endoscopy procedure.
- Turn on the Wi-Fi switch on the MiroCam® Receiver System during the Capsule Procedure.

⚠️ NOTE For more information on the MiroCam® capsule endoscope procedure, please refer to Chapter 3, Performing Capsule Endoscopy.
Click the icon on the desktop to launch MiroView™ RTV.

Click the button on the right-top to show the available MiroCam® Receiver Access Points.
If no available Receiver® Access Points are shown on the list, the image will appear like below. Please make sure that the Wifi-Switch on the Receiver is turned on.

If the MiroCam® Receiver Access Points are shown on the list. Click the desirable AP (Access Point) to show the patient's image.
At the first time to connect to the AP, IP setting is required as below steps:

- Step 1. Press the Home Button on the I-Phone/I-Pad/I-Pod touch to close the Wireless MiroView™ RTV Software.

- Step 2. Run the Settings for the I-OS.
Step 3. Set the IP for the desirable AP. (Setup as Static; IP Address: 192.168.3.200, Subnet Mask: 255.255.255.0)
After completing the IP setting, close the setting window by clicking the home button on the I-Phone/I-Pad/I-Pod touch and go back to the desktop.
6.2.2 Running MiroView™ RTV

- Fallow the MiroCam® capsule endoscopy procedure.
- Turn on the Wi-Fi switch on the MiroCam® Receiver System during the Capsule Procedure.

NOTE For more information on the MiroCam® capsule endoscope procedure, please refer to Chapter 3, Performing Capsule Endoscopy.
Click the icon on the desktop to launch Wireless MiroView™ RTV.

The Splash window will appear for a while and will disappear.
Chapter 6  Using Wireless MiroView™ RTV

- After the splash window disappears, the real time play will be started automatically. (The number of receiver is one).

※  If there are two or more Receiver AP is available, the Receiver AP List window will be shown. Choose one to continue as below:

- After reviewing the real time play is completed, click the home button to close.
To terminate the Software completely, double click the home button. The menu will pop up like below.

Press the Wireless MiroView RTV icon for a while. The 📺 mark will appear.
■ Click the icon, then the Wireless MiroView RTV will be terminated completely.

⚠️ **CAUTION** Wireless MiroView™ RTV is not to be used for diagnostic purposes. Use the MiroView™ software for viewing the patient images for diagnostic purposes.

6.2.3 **After Using Wireless MiroView™ RTV**

■ Turn off the Wi-Fi switch on the MiroCam® receiver system.
■ Continue MiroCam® capsule endoscope procedure.
Appendix
# CASE REPORT FORM

<table>
<thead>
<tr>
<th>Subject No.:</th>
<th>Subject Initials :</th>
<th>Center No.:</th>
</tr>
</thead>
</table>

Principal Investigator:  
Center Name:  
Address:  
Telephone No.:  
Fax No.:  
E-mail:  

CONFIDENTIAL
### Screening

<table>
<thead>
<tr>
<th>Subject No.:</th>
<th>Subject Initials:</th>
<th>Center No.:</th>
</tr>
</thead>
</table>

**Date of Informed consent signed**

<table>
<thead>
<tr>
<th>D</th>
<th>M</th>
<th>M</th>
<th>Y</th>
<th>Y</th>
<th>Y</th>
<th>Y</th>
</tr>
</thead>
</table>

### Inclusion Criteria

<table>
<thead>
<tr>
<th>Inclusion Criteria</th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Informed consent form voluntarily signed</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2. Male / Female subject of age 19 years~70 years.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If there is one or more mark of ‘No’, you shall be contradicted for this clinical test.

CONFIDENTIAL
## Case Form Report

**Trial ID:**

**Version No.: 1.0 : 30/07/2007**

---

### Screening

<table>
<thead>
<tr>
<th>Subject No.:</th>
<th>Subject Initials:</th>
<th>Center No.:</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>Date of visit:</th>
<th>D</th>
<th>M</th>
<th>M</th>
<th>Y</th>
<th>Y</th>
<th>Y</th>
<th>Y</th>
</tr>
</thead>
</table>

### Exclusion Criteria

<table>
<thead>
<tr>
<th></th>
<th>Yes</th>
<th>No</th>
<th>N/A</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. <strong>Do you have a gastrointestinal disorder</strong> (suspected malignant lesions or gastrointestinal obstructive disorders, perforation, stenosis or fistula)?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>2. <strong>Do you have a cardiovascular disorder</strong> (dysrhythmia, trouble with cardiac conduction system, hypertension (high blood pressure) or ischemic heart disease)?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>3. <strong>Have you been diagnosed of cardiac insufficiency, angina pectoris or cardiac arrest (heart attack) in recent 6 months</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>4. <strong>Are you with (or implanted) medical devices such as cardiac pacemaker or defibrillator</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>5. <strong>Do you have a swallowing disorder</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>6. <strong>Do you have delayed gastric emptying or serious gastric disorder</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>7. <strong>Are you a pregnant or nursing woman, or a woman of child bearing potential</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>8. <strong>Are you an infant or epileptic? Are you easily affected by electronic waves</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>9. <strong>Do you have several small bowel diverticulums</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>10. <strong>Did you fail to obtain a voluntary agreement</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>11. <strong>Are you judged unqualified for this test by doctors or nurses</strong>?</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

If there is one or more mark of ‘Yes’, you shall be contradicted for this clinical test.

CONFIDENTIAL
EC Representative
SeDa S.p.A
20090 Trezzano sul Naviglio (MI),
Via Toistoi, 7 Italy
Key Contact: Roberta Cimolato
Office: +39-02-484241
Mobile: +39-02-48424290
Email: roberta.cimolato@sedaitaly.it

IntroMedic Co., Ltd.
Suite 1104, E&C Venture Dream Tower 6-Cha
197-28 Guro-Dong, Guro-Gu, Seoul, KOREA 152-719
Tel: +82-2-801-9300
Fax: +82-2-801-9330
http://www.intromedic.com
e-mail: help@intromedic.com